MICRO-EPSILON

Operating Instructions

thermoMETER TIM 8
thermolMAGER TIM 40 / TIM 41




Spot finder IR camera

MICRO-EPSILON
MESSTECHNIK
GmbH & Co. KG
Koenigbacher Str. 15

94496 Ortenburg / Germany

Tel. +49 (0) 8542 / 168-0

Fax +49 (0) 8542 / 168-90
e-mail info@micro-epsilon.com
www.micro-epsilon.com



Contents

1. £ T =1 7
1.1 SYMDOIS USEA ...ttt b e bt h et e h e e a e s bt e e ek bt e e ab e e s ab e e e s bt e nab e e s nb e e et e e nnneennneas 7
1.2 L= g T o 1= PRSPPI 7
1.3 NOLES ON CE MAIKING ....eeeteei ittt ettt ekt e bt e b et ekt ebb e e nae e e sabeeenbeenaneesnneas 8
1.4 a1 (=T g o [=To I 0 LT PP RRI 9
1.5 (e deT o 1Tl =1 V7 {o] o Ta 1Y o | RSO RP 9
2. QLT L L= I
2.1 L8[ Ter (1o g F= T o g Lo o = U TP RO UR PR PR
2.2 1 [ Te [T @ =T 4 =TT RR PP UR PP
2.3 GENEIAl SPECITICALIONS. ... ettt e e bbbt e bt et nae e s be e s b e et e e beenneenneanes
24 Vibration / Shock ........cccooevivininieene.

2.4.1 Used Standards

2.4.2 Stress Program (Camera in OPeration) ..........ooueeiieeiieeiniie e 12
2.5 EleCtriCal SPECIHICALIONS. ... .iiuiiiiiiiiee ettt b bbbt ne e e e e e s 14
2.7 Measurement SPECITICATION .......iiiiiiiiicie e e e ettt e e ae e e st e e e e s b e e e s nba e e e arees 15
3. 9 T T 16
3.1 Unpacking, INCIUAEd iN DEIIVETY.........couiiiii e 16
3.2 S 100] = To [T OSSOSO PRTOUPTOTPPOPRTN 16
4, (0 o)1 o= 103 1 - T 3T 17
4.1 Lenses therMOMETER TIM 8. ettt ettt e ettt e e et ee e ssb e e e e ennee e e s nbeeeeanneeas 20
4.2 Lenses therMOIMAGER TIM 40 .........oiiiiiiiie ettt ettt ae e st e ae e snn e e s nneennneennns 21
4.4 Lenses therMOIMAGER TIM 471 ...ttt e et e ettt e nae e e st e e sse e e saeeesneeeameeesneeeeneeeaneeenneen 22
5. Mechanical Installation ... 23
5.1 DIMENSIONAI DIAWINGS ...ttt b ettt e bt et e e be e e ket e ket e eae e e sbb e e asb e e nnneesnbeeenteennnes 23
6. Electrical Installation............ccociiiimmmmimiiiniee s 28
6.1 ProCESS INEITACE ... ..ttt e e ettt e e e e e s nbe e e e e bt e e e s anbeeeeanneeas 29
6.2 Process Interface thermoMETER TIM 8 / thermoIMAGER TIM 41.......cooiiiiiiiiiiii e 29
6.3 Process Interface thermoIMAGER TIM 40.........oouiiiiiiiie et ee e saee e sree e nee e sneeesneeeaneeennes 32
6.4 Pin Assignment thermoMETER TIM 8 / thermoIMAGER TIM 41 ..ot 34
6.5 Pin Assignment thermOIMAGER TIM 40 ........ooiiiiiiieitieii et b e bt nneenreen 35

thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41



7. L0 0 4411317 (o] 411 4T 36
8. Instructions for Operation..........cccimrriinirr e ———— 37
8.1 (0] 1T o 1o Vo RS OTOTR 37
9. Software TIM CONNECT........ccceiiiiinmirriissr s n s e s snnn e e e nan 38
9.1 Minimum SyStem REQUITEIMENTS ........oiuiiiiiiieii ettt sb e b e bttt e tesaeesbeenbeen 38
9.2 Installation and INitial OPEratioN ............coouiiiiiiiiie et e e b e e sbeeesaeeeseeeas 38
9.3 Autonomous Operation thermoMETER TIM 8 / thermoIlMAGER TIM 41 ..o 41

9.3.1 Special Settings for thermoIMAGER TIM 41 ......ooiiiiieii e 43

9.3.2 Hot-/Coldspot Function in AUtonomous OPeration .............ccoeeuereeieeniienieeie e 46
9.4 Ethernet thermoMETER TIM 8 / thermOIMAGER TIM 47 ..ot 47

9.41 Ethernet Setup (Point-to-Point-ConNECiON) ..........cccuiiiiiiiiiiii e 48
9.5 Basic Features of SOftware TIM CONNECT...........ccuiiiiiiiii et 52
10. Basics of Infrared Thermometry........cccciiiiimirinninr 55
10.1 1] (g o [8 o1 110 o FAR OO PRSP O PSP S PSPPSR 55
10.2 YN o] o] [[er=1Te] g =bte=a ] o] [ ST PU PP UPPRPTPP 58
11. EMISSIVITY . eiiiiiiiiiisnnnnrrrrs iR 59
111 DL 0111 o O OO ROP PR PRPOPRPRT 59
11.2 Determination of UnNKNOWN EMISSIVITY .......cccuiiiiiiiiieiicii e 61
11.3 CharaCteriStiC EMISSIVITY ......eetiiiiiiiiie ittt ettt b e bbbt et e e e nb e sb e e st e e nbe et e snnesnnas 63
12. [ T =T o7 = 1] = 64
13. L= T =T - T 65
14. Decommissioning, DiSPOSal......ccccccmmrrririiiiniiiiiisssssnrrr s 66

thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41



Appendix

A1 o oL T TN 67
A1A1 F NI VT o= = o o= U PT PR 67
Al2 L L= G @ToTo] 1 0 To [ PR PTROPP 71
A13 S T (=T USSP 73
Al4 Combination of Air Purge, Water Cooling and SHULET ..........coouiiiiiiiiiiie e 77
A15 OULdOOr ProteCHIVE HOUSING .....eiueiiiiiiieiti ettt b bbbt sae e s b et e e bt e b e eneeeanesees 82
A16 Hardware and SOTIWAIE ..........ueiiiii ittt b et bb e sae e e s bb e e st e e sateesabeesnteenanes 83
A2 Factory Settings ......ccccvrriiiiiiniinneirirr s s 83
A3 Emissivity Table Metals.........ccooimiii e 84
A4 Emissivity Table Non Metals.........coommiimmimimmmimiii s 87
A5 Industrial Process Interface for thermoMETER TIM 8 (Optional)........cccvvniiiiinnnmemmnnnnnnnnnns 89
A6 Industrial Process Interface for thermolMAGER TIM 40 (Optional)........ccoccceivmmmmmnnnnnnnnnnns 93
A7 Examples for a Fail-Safe Monitoring with @ PLC ..........ccccciiiiimimse s ssnsnnnes 96
A8 USB Cable Extension for thermolMAGER TIM 40 ........ccccoeiriiiininssssssnnnnesssnsssssssssssnns 98
A9 A Quick Start for Serial CommUNICAtION. .........ceeiiiiiiiiii i ——— 99
A9.1 a1 1o To 18 o7 1o o 1RSSR 929
A9.2 SEtUP OF the INTEITACE ...ttt sttt nb e e be e e bt e e nbeeesbeeenn 99
A93 (07T 0 01010 To [ I8 USSP 99
A10 A Brief Overview to DLL Communication (IPC)..........ccoccmmiiniimmrmincssns s sssssssssssssnnes 100
A11 thermolMAGER TIM Connect Resource Translator............cccoevmmmemmmmrmmmsssssssssssssseeessssseeens 101
A12 Process Interface for thermolMAGER TIM 40 .......ocooviiiiiiiiccccccsmmmeeererreesssssssssssssmmsssssssssenas 102
Al2.1 F N aE= 1o T [ O 104 o 11 | SO PO P U RPP 102
A12.2 Digital Input...... ...102
A123 Analog INpUt........ccoeeiiiiiiieeeee ...103
A124 Relay Output on INAUSEHAl INTEIMACE............iieiiiieee e 104

thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41



thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41



Safety
1. Safety
System operation assumes knowledge of the operating instructions.

1.1 Symbols Used

The following symbols are used in these operating instructions:

Indicates a hazardous situation which, if not avoided, may result in minor or mode-
A CAUTION rate injury.
NOTICE Indicates a situation that may result in property damage if not avoided.

) | Indicates a user action.
1 Indicates a tip for users.
Measure Indicates hardware or a software button/menu.

1.2 Warnings

A CAUTION Connect the power supply and the display/output device according to the safety regulations for electrical

equipment.
> Risk of injury

> Damage to or destruction of the camera
NOTICE Avoid the alignment of the camera to intensive energy sources (e.g. devices which emit laser radiation or
reflections of such equipment). This is also valid if the camera is switched off.
> Effect on the accuracy of the measurement
> Irreparable defect of the infrared detector

Avoid static electricity, arc welders, and induction heaters. Keep away from very strong EMF (electromagnetic
fields).
> Damage to or destruction of the camera
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Safety

Avoid shocks, impacts and vibration to the camera.
> Damage to or destruction of the camera

The supply voltage must not exceed the specified limits.
> Damage to or destruction of the camera

No solvent-based cleaning agents may have an effect on the camera (neither for the optics nor the housing).
> Damage to or destruction of the camera

Avoid abrupt changes of the ambient temperature.
> Incorrect display of the device

Protect the USB cable against damage.
> Failure of the camera

1.3 Notes on CE Marking

The following apply to the thermolMAGER TIM:

- EU Directive 2014/30/EU

- EU Directive 2011/65/EU

Products which carry the CE mark satisfy the requirements of the EU directives cited and the relevant appli-
cable harmonized European standards (EN). The measuring system is designed for use in industrial environ-
ments.

The EU Declaration of Conformity and the technical documentation are available to the responsible authori-
ties according to the EU Directives.
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Safety

1.4 Intended Use

- The thermolMAGER TIM is designed for use in industrial and laboratory areas. It is used for measuring the
surface temperature based on the emitted energy of objects, see 10.

- The system must only be operated within the limits specified in the technical data, see 2.

- The system must be used in such a way that no persons are endangered or machines and other material
goods are damaged in the event of malfunction or total failure of the system.

- Take additional precautions for safety and damage prevention in case of safety-related applications.

1.5 Proper Environment

Protection class: IP67 (NEMA-4)

- Operating temperature: 0 ... +50 °C (+32 ... +122 °F)
- Storage temperature: -40 ... +70°C (40 ... +158 °F)
Relative humidity: 10 ... 95 %, non-condensing

NOTICE Avoid abrupt changes of the ambient temperature.
> Incorrect display of the device
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Technical Data

2. Technical Data

2.1 Functional Principle

The thermoMETER TIM 8 and the thermolMAGER TIM 40 calculates the surface temperature based on the
emitted infrared energy of objects, see 10. The two-dimensional detector (FPA - focal plain array) allows a
measurement of an area and will be shown as thermographic image using standardized palettes. The radio-
metric processing of the picture data enables the user to do a comfortable detailed analysis with the software

TIM Connect.

2.2 Model Overview

The cameras of the TIM series are available in the following basic versions:

TIM 41

USB: 4 Hz

Model Type |Temperature range |Spectral range |Frame rate Typical applications
thermoMETER |IR -20 t0 900 °C 8-14um USB/Ethernet: | Surface measure-
TIM 8 50 Hz ments in industrial
application, autono-
mous operation with
automatic spot finder
thermolMAGER | IR -20 t0 900 °C 8-14um USB: Real-time thermo-
TIM 40 80 Hz /27 Hz graphic images in
high speed; Detection
of smallest tempera-
ture differences
thermolIMAGER | IR -20 t0 900 °C 8-14um Ethernet: 25 HZ | Surface measure-

ments in industrial
application, autono-
mous operation with
automatic spot finder

thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41
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Technical Data

2.3

General Specifications

Model

thermoMETER TIM 8 ‘ thermolMAGER TIM 40 ‘ thermolMAGER TIM 41

Protection class

IP 67 (NEMA-4) 1

Operating temperature

0..50°C (+32... +122 °F)

Storage temperature

-40 ... 70 °C (-40 ... +158 °F)

Relative humidity

10 ... 95 %, non-condensing

Material (housing)

Stainless steel

Dimensions

36 x 90 mm / M30

36 x 100 mm / M30

Weight (inclusive lens)

201-221g
(depending on optics)

216-220g
(depending on optics)

Cable length (USB) USB | 1 m (Standard),3m,5m | 1 m (Standard), 3m,5m, | 1 m (Standard), 3m,5m
10m, 20 m
Ethernet/ RS485 100 m - 100 m
Vibration ' IEC 68-2-6: (sinus shaped), see 2.4
IEC 60068-2-64 (broadband noise), see 2.4
Shock ! IEC 68-2-27: 25 g and 50 g, see 2.4

1) Used standards for vibration and shock

thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41
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Technical Data

2.4 Vibration / Shock

2.4.1 Used Standards
IEC EN 60068-1: 1995-03
IEC 60068-2-6: 2008-10

IEC 60068-2-27: 2010-02

IEC 60068-2-47: 2006-03

IEC 60068-2-64: 2009-04

2.4.2 Stress Program (Camera in Operation)

Environmental testing - Part 1: General and guidance
Environmental testing - Part 2-6: Tests - Test Fc: Vibration
(sinusoidal)

Environmental testing - Part 2-27: Test Ea and guidance:
Shock

Environmental testing - Part 2-47: Mounting of specimens
for vibration, impact and similar dynamic tests
Environmental testing - Part 2-64: Tests -

Tests Fh: Vibration, broadband random and guidance

Shock, half sinus 25 g - testing Ea 25 g (acc. IEC 60068-2-27)

Acceleration 245 m/s? (25 g)

Pulse duration 11 ms

Number of directions 6 (3 axes with 2 directions each)
Duration 600 shocks (100 shocks each direction)

Shock, half sinus 50 g - testing Ea 50 g (acc. IEC 60068-2-27)

Acceleration 490 m/s? (50 g)

Pulse duration 11 ms

Number of directions 6 (3 axes with 2 directions each)
Duration 18 shocks (3 shocks each direction)

thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41
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Technical Data

Vibration, sinus shaped - testing Fc (acc. IEC60068-2-6)

Frequency range 10 - 500 Hz

Acceleration 29.42 m/s? (39)
Frequency change 1 octave/ min

Number of axes 3

Duration 1:30 h (3x0.30 h)

Vibration, broadband noise - testing Fh (acc. IEC60068-2-64)

thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41

Frequency change 10 - 2000 Hz
Acceleration, effective 39.3 m/s? (4.01 ggye)
Frequency spectrum 10-106 Hz 0.9610 (m/s?)?/Hz (0.010 g? /Hz)

106 - 150 Hz +6 dB/ octave

150 - 500 Hz 1.9230 (m/s?)?/Hz (0.020 g?/Hz)

500 - 2000 Hz -6 dB/ octave

2000 Hz 0.1245 (m/s?)?/Hz (0.00126 g2/Hz)
Number of axes 3
Duration 3h (Bx1h)
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25 Electrical Specifications

face (PIF out)

Model thermoMETER TIM 8 thermolMAGER TIM 40 thermolMAGER TIM 41
Power supply USB/ PoE/ 5 - 30 VDC usB USB/ PoE/ 5 - 30 VDC
Current draw max. 500 mA

AO: Output Process Inter- 0/4 - 20 mA 0-10V 0/4-20 mA

(Main measure area, measure area, internal temperature, flag status, alarm, frame sync, fail-safe,
external communication), see A 12.

Al: Input Process Interface
(PIF in)

0 - 10 V (Emissivity, ambient temperature, reference temperature, uncommitted value, flag control, trig-
gered recording, triggered snapshots, triggered line-scanner, triggered event grabber,
reset peak-/valley-hold), see A 12.

DI: Digital Input Process
Interface

Flag control, triggered recording, triggered snapshots, triggered line-scanner, triggered event grabber,

reset peak-/valley-hold

DO: Digital Output Pro-
cess Interface

Flag Status, alarm, frame sync, fail-safe, external communication

Digital interface

USB 2.0/ Ethernet/ RS485

USB 2.0/ optional USB to GigE

(PoE) conversion

USB 2.0/ Ethernet/ RS485

thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41
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2.7 Measurement Specification

80 x 80 Pixel @ 50 Hz

Model thermoMETER TIM 8 thermolMAGER TIM 40 thermoIlMAGER TIM 41
Temperature ranges -20 ... 100 °C; 20 ... 100 °C; -20 ...100 °C; 0 ... 250 °C;
(scalable) 0...250 °C; 0...250 °C; (20) 150...900°C "

(20) 150...900°C " (20) 150 ...900°C "

Spectral range 8-14um

Detector UFPA, UFPA, UFPA,

382 x 288 Pixel @ 80 Hz/27

Hz Ethernet: 384 x 240 Pixel @ 25 Hz
USB: 384 x 240 Pixel @ 4 Hz

Lenses (FOV)

12°x12° (F=1,0);
30° x 30° (F=0,9);
55° x 55° (F=0,9);
80° x 80° (F=0,9)

18°x 14° (F=1,1);
29° x 22° (F=0,9):
53° x 38° (F=0,9):
80° x 54° (F=0,9)

18°x 12° (F=1,1); 29° x 18° (F=0,9);
53° x 31° (F=0,9); 80° x 44° (F=0,9)

Optical resolution (D:S)

190:1 (12° optic)

390:1 (18° optic)

System accuracy ?

+2°Cor 2 %

Temperature resolution
(NETD)

100 mK

80 mK

Warm-up time 10 min
Emissivity 0.100 ... 1.100
Software TIMConnect

1) Accuracy statement effective from 150 °C

2) At ambient temperature 23=5 °C; whichever is greater.

thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41
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Delivery
3. Delivery

3.1 Unpacking, Included in Delivery

1 thermoMETER TIM 8, thermolIMAGER TIM 40 or thermolMAGER TIM 41

1 USB cable (1 m")

1 Ethernet PoE cable: 1 m (only for thermolIMAGER TIM 41)

1 Mounting nut and mounting bracket (adjustable in one axis, tripod thread)
1 Process interface cable inclusive terminal block (1 m)

1 USB stick with software package TIM Connect

1 Assembly instructions

E3 cCarefully remove the components of the measuring system from the packaging and ensure that the
goods are forwarded in such a way that no damage can occur.

E3 Check the delivery for completeness and shipping damage immediately after unpacking.
E3 ifthereis damage or parts are missing, immediately contact the manufacturer or supplier.

Optional accessories are available in the appendix, see A 1.

3.2 Storage

- Storage temperature: -40 ... +70 °C (-40 ... +158 °F)
- Relative humidity: 10 ... 95 %, non-condensing

1) The camera plug of USB cable (1 m) does not feature an IP67 protection class. For industrial applications
there are cables with 1 m, 3 m, 10 m and 20 m with IP67 available as optional accessories.

thermoMETER TIM 8 / thermolIMAGER TIM 40 / TIM 41 Page 16



Optical Charts

4. Optical Charts

Make sure that the focus of thermal channel is adjusted correctly. The cameras have a motorized focus,
1 which can be adjusted in the TIM Connect Software via Menu View > Windows > Distance Or over
the icon i . An adjustment to the left leads to the focus setting “near” and an adjustment to the right to
the focus setting “infinite”.

Distance @

WeE —m ()33 1

442

Fig. 1 Motorized focus settings in TIM Connect software
The variety of different lenses offers the possibility to precisely measure objects in different distances. We of-
fer lenses for close, standard distances and large distances.

Please note that the TIM camera has a fixed optic. A change of optics is not possible.
1 Please note that the motorized focus should only be used for startup and installation purposes and that
permanent movement of the focus motor is not allowed.

Different parameters are important if using infrared cameras. They display the connection between the dis-
tance of the measured object and the size of the pixel, see Fig. 3, see Fig. 4, see Fig. 5.
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Optical Charts

Fig. 2 Dependency between field of view (FOV) and distance

HFOV | Horizontal enlargement of the total measuring at object level
VFQOV | Vertical enlargement of the total measuring at object level
IFOV | Size at the single pixel at object level

DFOV | Diagonal dimension of the total measuring field at object level

MFOV | Recommended, smallest measured object size of 3 x 3 Pixel (thermolMAGER TIM 40 / TIM 41)
and 2 x 2 (thermoMETER TIM 8), not shown in the drawing above, see Fig. 2.
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Optical Charts

Geometric resolution for ideal temperature measurement

When designing optics for measuring IR cameras, special attention must be paid to the quality of detail
contrast with which an object can be represented in the image. This is described by the modulation transfer
function (MTF). Since in contrast to visual cameras, with IR cameras the thermal contrast is of more interest,
this is used together with the slit response function (SRF). The result is determined by the number of pixels
an object needs to fill to allow its temperature to be measured exactly. In high-performance infrared optical
systems, this is 3x3 pixels or 2x2 pixels. A high-performance camera lens also allows a larger measuring
distance with the same number of pixels of the detector, or the precise temperature measurement of smaller
structures and objects. The 3x3 pixel (2x2 pixel) geometry is described as MFOV (measurement field of
view) - one single pixel on the object surface is described as IFOV (instantaneous field of view). The MFOV is
comparable with the measuring spot definition with infrared thermometers.

The following tables with examples showing what spot sizes and pixel sizes will be reached in which distance.
For individual configuration there are different lenses available. Wide angle lenses have a radial distortion due
to their large opening angle; the software TIM Connect has an algorithm which corrects this distortion. As an
alternative to the tables below, the optics calculator can also be used. You will find the latest software at:
https://www.micro-epsilon.com/temperature-sensors/thermolMAGER/optics/
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Optical Charts
4.1 Lenses thermoMETER TIM 8

Ul e < % Distance to measurement object [m]
[$) £ -
< E0 o
© 550
BT 2 E2 S
o E 2 €35 0.05 0.1 0.2 0.3 0.5 1 2 4 6 10 30 100
80 x 80 px 2 E < SeEo
30° 30° HFOV [m] 0.028 0.056 0.111 0.167 0.279 0.557 1.115 223 3.346 5.6 16.7 55.8
Standard lens 30° 02m VFOV[m] 0.028 0.056 0.111 0.167 0.279 0.557 1.115 223 3.346 5.6 16.7 55.8
6.67 mrad IFOV [mm] 033 067 133 20 3.33 6.67 13.33 26.67 40.0 66.67 200.0 666.67
190 12° HFOV [m] 0.022 0.043 0.065 021 021 043 085 1.28 2.1 6.4 213
Telephoto lens 12° 0.3m VFOV [m] 0.022 0.043 0.065 0.11 021 043 085 128 2.1 64 213
P 2.66 mrad IFOV [mm] 0.3 0.5 0.8 1.3 2.7 5.3 106 159 26.6 79.7 265.6
55° 555 HFOV [m] 0.057 0.110 0.218 0.325 0.539 1.07 2.14 427 6.41 10.7 32.0 106.7
Wide angle 3 55° 02m VFOV[m] 0.057 0.110 0.218 0.325 0.539 1.07 214 427 6.41 10.7 320 106.7
lens 11.15 mrad IFOV [mm] 0.6 1.2 23 3.4 5.6 112 224 446 669 1115 3345 11148
80° 80° HFOV [m] 0.090 0.174 0.343 0.509 0.884 1.682 3.357 6.708 10.058 16.8 50.3 167.5
Super wide 2 80° 02m VFOV[m] 0.090 0.174 0.343 0.509 0.88 1.682 3.357 6.08 10.058 16.8 50.3 167.5
angle lens 15.45 mrad IFOV [mm] 0.08 1.6 3.2 4.7 7.8 155 31.0 619 928 154.6 463.7 1545.5

Fig. 3 Table with examples (TIM 8) showing what spot sizes and pixel sizes will be reached in which distance

FOV: Horizontal enlargement of the total measuring field at object level
VFOV: Vertical enlargement of the total measuring field at object level
IFOV: Size of the single pixel at object level

1) The accuracy of measurement can be outside of the specifications for distances below the defined minimum distance.
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Optical Charts

4.2 Lenses thermolMAGER TIM 40

TIM 40 < ;E, Distance to measurement object [m]
o € -
5 ESo
W S5 5 0
8¢E % g%% 0.05 0.1 0.2 0.3 0.5 1 2 4 6 10 30 100
(&) = 5 R b b e 5
382x288px LE £ =Sg2
29° 29° HFOV [m] 0.059 0.111 0.16 027 053 1.06 2.1 3.2 538 15.8 525
Standard lens 13 22° 0.35m VFOV [m] 0.043 0.082 0.12 020 039 078 15 2.3 3.9 11.6 385
1.3 mrad IFOV [mm] 0.2 0.3 0.4 0.7 1.4 2.8 5.5 8.3 13.8 412 1374
18° 18° HFQV [m] 0.069 0.102 0.17 033 066 130 1.9 3.2 9.7 324
Telephoto lens 14° 0.35m VFOV [m] 0.051 0.076 0.12 025 049 098 15 2.5 7.4 24.6
P 0.9 mrad IFOV [mm] 0.2 0.3 0.4 0.9 1.7 3.4 5.1 8.5 254 848
53° 53° HFQV [m] 0.099 020 030 049 099 20 4.0 5.9 9.9 296 98.6
Wide angle 8 38° 0.25m VFOV [m] 0.071 0.14 021 034 068 1.4 2.7 41 6.8 204 68.1
lens 2.2 mrad IFOV [mm] 026 053 078 1.3 2.6 52 104 155 259 775 2582
80° 80° HFOV [m] 0.084 0.16 032 048 081 1.6 3.3 6.5 9.8 16.6 499 166.4
Super wide 6 54° 02m VFOV[m] 0.056 0.11 021 0331 051 1.0 2.0 4.1 6.1 102 30.6 1019
angle lens 3.0 mrad IFOV [mm] 0.2 0.4 0.8 1.3 2.1 4.2 8.5 170 257 43.6 130.7 4355

Fig. 4 Table with examples (TIM 40) showing what spot sizes and pixel sizes will be reached in which distance

FOV: Horizontal enlargement of the total measuring field at object level
VFOV: Vertical enlargement of the total measuring field at object level
IFOV: Size of the single pixel at object level

1) The accuracy of measurement can be outside of the specifications for distances below the defined minimum distance.
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Optical Charts
4.4 Lenses thermolMAGER TIM 41

g < :% Distance to measurement object [m]
) =i
= ES o
@ 550
8€E % £gs 0.05 0.1 0.2 0.3 0.5 1 2 4 6 10 30 100
o = 7 A b 5 B .
384x240px S E & sg2
29° 29° HFOV [m] 0.059 0.112 0.17 027 053 1.07 2.1 3.2 5.8 159 529
Standard lens 13 18° 0.35m VFOV [m] 0.086 0.068 0.10 0.16 032 064 13 1.9 3.2 915 31.7
1.4 mrad IFOV [mm] 0.2 0.3 0.4 0.7 1.4 2.8 BB 8.3 138 413 1377
18° 18° HFQV [m] 0.069 0.102 0.17 033 066 131 20 3.3 9.8 32.6
Telephoto lens 12° 0.35m VFOV [m] 0.043 0.064 0.10 021 041 082 1.2 2.1 6.1 20.5
P 0.9 mrad IFOV [mm] 0.2 0.3 0.4 0.9 1.7 3.4 5.1 8.5 255 84.8
53° 53° HFOV [m] 0.100 020 030 049 099 20 4.0 519 9.9 29.7 98.9
Wide angle 8 31° 0.25m VFOV [m] 0.057 0.11 0.17 028 055 11 22 3.3 515 165 549
lens 2.6 mrad IFOV [mm] 0.3 0.5 0.8 1.3 2.6 5.1 10.3 155 258 772 257.4
80° 80° HFOV[m] 0.084 0.16 032 048 081 1.6 3.3 6.5 9.8 166 499 166.4
Super wide 6 44° 02m VFOV[m] 0.044 0.08 0.17 025 041 0.8 1.6 3.2 4.8 8.0 241 804
angle lens 4.3 mrad IFOV [mm] 0.2 0.4 0.8 1.3 2.1 4.2 8.5 169 255 434 130.0 433.2

Fig. 5 Table with examples (TIM 41) showing what spot sizes and pixel sizes will be reached in which distance

FOV: Horizontal enlargement of the total measuring field at object level
VFOV: Vertical enlargement of the total measuring field at object level
IFOV: Size of the single pixel at object level

1) The accuracy of measurement can be outside of the specifications for distances below the defined minimum distance.
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5. Mechanical Installation

The thermoMETER TIM 8 and the thermolMAGER TIM 40 / TIM 41 are equipped with a metric M30x1 thread
and can be installed either directly via the sensor thread or with help of the supplied mounting nut (standard)
and adjustable mounting bracket (standard) to a mounting device available, see Fig. 7.

5.1 Dimensional Drawings

Fig. 6 thermoMETER TIM 8 | thermoIMAGER TIM 40 | TIM 41 with mounting bracket

$6.50

i | @

L Iy

17
A e

A

30,50

e 14,
(55)

(60)
N

]l

60

le(28)

45"

Fig. 7 Mounting bracket, adjustable in one axis, with tripod thread

For correct orientation, the USB port must be on the left side and the PIF port on the right side, see Fig.
1 8, see Fig. 9, see Fig. 10.
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Fig. 8 Dimensional drawing thermoMETER TIM 8, dimensions in mm
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Fig. 9 Dimensional drawing thermoMETER TIM 40, dimensions in mm
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Fig. 10 Dimensional drawing thermoIMAGER TIM 41, dimensions in mm
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Fig. 11 Industrial/stackable PIF (Process Interface) - electronic box, control box shutter, dimensions in mm
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6. Electrical Installation

At the back side of the thermoMETER TIM 8 / thermolIMAGER TIM 41 and the thermolMAGER TIM 40 cam-
eras there are the two connector plugs, see Fig. 12, see Fig. 13.

Fig. 12 Back side of the thermoMETER TIM 8 / Fig. 13 Back side of the thermolIMAGER TIM 40 with
thermolMAGER TIM 41 with connectors connectors

1 Plug for USB/ Ethernet " / PoE cable 1 Plug for USB cable

2 Plug for in- and outputs or RS485 2 Plug for PIF cable

1) When using the Ethernet interface, either a PoE source ora 5 ... 30 V DC power supply via the terminal
block must be used.
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6.1 Process Interface

6.2 Process Interface thermoMETER TIM 8 / thermolMAGER TIM 41

The thermoMETER TIM 8 / thermolMAGER TIM 41 is equipped with an integrated process interface (cable
with terminal block included in scope of supply), which can be programmed via the software as an direct ana-
log input (Al) / digital input, as an direct analog output (AO) in order to control the process or as an RS485
interface ". The signal level is 0 - 10 V for Al, 24 V for DI and 0/4 - 20 mA for AO.

The process interface can be activated choosing the following options:

Analog Input (Al)

Emissivity, ambient temperature, reference temperature, uncommitted value, flag
control, triggered recording, triggered snapshots, triggered line-scanner, triggered
event grabber, reset peak-/valley-hold

Analog Output (AO)

Main measure area, measure area, internal temperature, flag status, alarm, frame
sync, fail-safe, external communication

1) Power supply only necessary when using the Ethernet connection (without PoE) or self-sufficient opera-

tion.
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O

Fig. 14 Configuration terminal block thermoMETER TIM 8 | thermolIMAGER TIM 41

Designation Description Color
L Shield Black
GND oV Ground Brown
VCC 5-30V |Power supply " White
IN A Analog/Digital Input or RS485 (A) Green
ouT B Analog output or RS485 (B) Yellow
GND ISO Isolated Ground for IN and OUT Gray

1) Power supply only necessary when using the Ethernet connection (without PoE) or self-sufficient operation
(minimum voltage when using the Ethernet connection: 12 V)
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The thermoMETER TIM 8 / thermolMAGER TIM 41 provides the following direct inputs and outputs:

Designation Description max range / status
Al Analog input 0-10V"
or Digital input 24V
DI (Low-active =0 ... 0.6 V)
AO Analog output 0/4 - 20 mA
Alarm output 0/4 - 20 mA

In addition to the above direct in- and outputs, the TIM 8 / TIM 41 has an RS485 interface. This interface can

be used to control the external industrial PIF.

1) The Al is designed for max. 24 V, the voltage level above 10 V is not interpreted.

thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41
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6.3 Process Interface thermolMAGER TIM 40
The process interface (electronics within cable as well as industrial interface) must be powered sepa-
1 rately (5 - 24 VDC).
E2 Connect the PIF cable to the camera before switching on the power.

The TIM is equipped with a process interface (cable with integrated electronics and terminal block), which
can be programmed via the software as an Analog Input (Al) and Digital Input (DI) in order to control the
camera or as an Analog Output (AO) in order to control the process. The signal level is always

0-10V (DI =24 V).

The process interface can be activated choosing the following options:

Analog input (Al) Emissivity, ambient temperature, reference temperature, uncommitted value, flag
control, triggered recording, triggered snapshots, triggered line-scanner, trig-
gered event grabber, reset peak-/valley-hold

Analog output (AO) Main measure area, measure area, internal temperature, flag status, alarm,
frame sync, fail-safe, external communication
Digital input (DI) Flag control, triggered recording, triggered snapshots, triggered line-scanner,

triggered event grabber, reset peak-/valley-hold
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ooonnn

PIF Electronics

Fig. 15 Configuration terminal block thermolIMAGER TIM 40

Designation Description Color
L Shield Black
GND Ground Brown
DI Digital input Gray

Vce Power supply, 5 ... 24 V DC White
Al Analog input Green
AO Analog output Yellow

The standard pro

cess interface can be activated choosing the following options:

Designation Description max range " / status
Al Analog input 0-10V?2
DI Digital input 24V
(Low-active =0 ... 0.6 V)
AO Analog output 0-10V
Alarm output 0/10V

1) Depending on supply voltage; for 0 - 10 V on the AO the PIF has to be powered with min. 12 V.
2) The Al is designed for max. 24V, the voltage level above 10 V is not interpreted.
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6.4 Pin Assignment thermoMETER TIM 8 / thermolIMAGER TIM 41

Pin |USB Ethernet |PIF

1 VCC VCC

2 D+ RS485 or AO
3 D- RS485 or Al
4 Tx+ GND

5 Tx- GND-ISO

6 Rx+

7 Rx-

8 GND

Fig. 16 Rear side thermoMETER TIM 8 | thermolIMAGER TIM 41 connector
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6.5 Pin Assignment thermolIMAGER TIM 40

Pin [USB |PIF

1 |vec [INT

2 |GND |[SDA (FC)
3 |D- SCL (IFC)
4 |D+ |DGND

5 |- 3.3V (Out)

Fig. 17 Rear side thermolMAGER TIM 40 connector

If the process interface of the camera is directly connected to external hardware ' (without using the supplied
PIF cable) an activation of the field Support proprietary PIF cable inthe menu Tools > Configu-

ration > Device (PIF) inthe TIM Connect software is necessary.

Support proprietary PIF cable

Fig. 18 Support proprietary PIF cable

i Consider that the input of the PIF is not protected if there is a direct PIF connection!

A CAUTION In this case, avoid a voltage > 3 V at INT pin.

> Destruction of the camera

1) We recommend using only a switching contact between INT and DGND as external hardware (button,

relay).
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Commissioning
Please install at first the software TIM Connect from the delivered USB stick, see 9.1.

Further information regarding software installation as well as software features you will find in the oper-
ating instructions from the delivered USB stick.
Now you can connect the thermolMAGER TIM camera into an USB port (USB 2.0) of your PC.

If connecting the thermolMAGER TIM camera and the computer please plug at first the USB cable into
the camera and then into the computer.

If disconnecting the thermolIMAGER TIM camera and the computer please remove at first the USB cable from
NOTICE the computer and then from the camera.

> Damage to or destruction of the camera

po—-g-

After the software has been started, you should see the live image from the camera inside a window on your
PC screen, see Fig. 19.

<o

T

Fig. 19 Live image of camera

At first start of software you will be asked to install the calibration data of camera. You will find them on the

delivered USB stick or can be accessed online via the Internet.

E3  Adjust the focus of the image by using the distance function in the software (menu View > Windows
> Distance orovertheicon i :

Fig. 20 Window Distance
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8. Instructions for Operation

8.1 Cleaning

Lens cleaning: Blow off loose particles using clean compressed air. The lens surface can be cleaned with a
soft, humid tissue moistened with water or a lens cleaner (e.g. Purosol or B+W Lens Cleaner).

NOTICE Never use cleaning compounds which contain solvents (neither for the lens nor for the housing).

> Destruction of the sensor and/or the controller
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9. Software TIM Connect

9.1 Minimum System Requirements

- Windows 7, Windows 10

- USB interface

- Hard disc with at least 30 MByte of free space

- Atleast 128 MByte RAM

A detailed description is provided in the software manual on delivered USB stick. See also Help menu in the
TIM Connect software under Help > Documentation.

9.2 Installation and Initial Operation

All drivers are booted via Windows OS automatically. A driver installation is not necessary. By default
1 the program starts automatically in the installed language.

E3 1. Insert the included USB stick an Ihrem PC an.

E3 2. Please start the Setup.exe. Follow the instructions of the wizard until the installation is finished.
The installation wizard places a launch icon on the desktop and in the start menu: start\Programs\TIM
Connect.

E3 3. To connect the camera to the PC, plug the USB cable to the camera first. Afterwards connect it with

the PC (to disconnect the camera and the computer remove the USB cable from the computer first and
then disconnect it from the camera).

E3 4. Start the software.

At the initial start the software asks for the calibration files which are available via internet or on the USB stick
(only for TIM 40). With the TIM 8 / TIM 41, the calibration files are already included in the device.

E3 5. Choose the desired language in the menu Tools > Language.

E3 6. Adjust the focus of the image by using the distance function in the software (Menu View > Win-
dows > Distance orovertheicon i :
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Fig. 21 Window Distance
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Fig. 22 Software window
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L]

Further information regarding software installation as well as software features you will find in the opera-
tion instructions.

They are available online at:
http://www.micro-epsilon.com/download/manuals/man--thermolMAGER-TIM-Connect--en.pdf

IR image from the camera

Temperature profile: Shows the temperatures along max. 2 lines at any size and position in the image.

Control displays: Displays all temperature values in the defined measure areas like Cold Spots, Hot
Spots, temperature at cursor, internal temperature and chip temperature.

Alarm settings: Bar showing the defined temperature thresholds for low alarm value (blue arrow) and
high alarm value (red arrow). The color of numbers within control displays changes to red (when
temp. above the high alarm value) and to blue (when temp. below the low alarm value).

Temperature of measure area: Analyses the temperature according to the selected shape, e.g. aver-
age temperature of the rectangle. The value is shown inside the IR image and the control displays.

Reference bar: Shows the scaling of temperature within the color palette.

Temperature time diagram: Shows the temperature curves over time for selectable region of interest
(ROI)

Histogram: Shows the statistic distribution of single temperature values.

Automatic / manual scaling of the palette (displayed temperature range): Man., </> (min, max), 1 : 1
Sigma, 30 : 3 Sigma, OPT: Palette optimization

9

Distance function: Adjustment of the motor focus to focus the IR picture

10

Menu and Toolbar (Icons)

11

Icon enabling switching between color palettes

12

Status bar: Serial number, optic, temperature range, cursor position, device framerate/ display frame-

rate, emissivity, ambient temperature, flag status

Further details to the software are in the enclosed USB stick.

thermoMETER TIM 8 / thermolIMAGER TIM 40 / TIM 41 Page 40


http://www.micro-epsilon.com/download/manuals/man--thermoIMAGER-TIM-Connect--en.pdf 

Software TIM Connect

9.3 Autonomous Operation thermoMETER TIM 8 / thermoIMAGER TIM 41

A special feature of the thermoMETER TIM 8 / thermolMAGER TIM 41 is the autonomous operation. There is

no need for a permanent connection to the TIM Connect software. Only a few settings must be set in advance

in the software.

E3 To do this, connect the PIF and Ethernet or USB cables to the device.

E=3 Then connect the thermoMETER TIM 8 / thermolMAGER TIM 41 to your PC and start the TIM Connect
software, see 9.

E2 Position and focus, see 4, the camera so that your object to be measured is perfectly visible in the im-
age.

E2 First define the desired measurement area with the corresponding mode you want to output.

TIM 8/ TIM 41 PIF cable

[

Terminal block
Ethernet

Fig. 23 Connection thermoMETER TIM 8 | thermolMAGER TIM 41 to PC via USB

E=2 Now go to the configuration menu on Device (PIF).

E3 There you first select the PIF type (in this case: Internal PIF). Then select under Analog Outputs (AO) the
function that is to be output autonomously.
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E3 Then press setup, make your settings and make sure that the checkbox is set to using autonomously
by device.

By pressing the OK button an @ sign can be found in the configuration menu Devices (PIF), which indicates the
autonomous operation.

Configuration '® Config PIF channel Sm]
Snapshots / Copy to clipboard | Trig. Recording / Snapshots | Capture Screen | Histogram | Extended measuring | Measuing colors | Process interface
IR Image amanging | Alamns | Event grabber | Extemal C¢ ication | Extended Layout | Interince 01
General | Measure areas | Temp. profiles | Temp/Time diagram | Device | Device (PIF) | Recording | Playing |
Modus: Measure area
PIF type: Intemal PIF
e i T Output mode: ~ [0..20mA ~
Analog Inputs (1) (=) (=) Measure area
Al: Not used v v [ sewp | Area 1 -
Digital Inputs (1) [)(=] using autonomously by device
DI: Not used v %[ Sewp | Configuration range:
Anslog Outputs (1) [=][=) -200°C .. 1000°C
AO: Measure area v ¥ [ Sep | @ Areal:4mA=0C/20mA=100"C Low Range
Temperature Current
Digitel Outputs (1) (=) (=) o B¢ = pw E™
DO: Not used v %[ Sewp | High Range
) Temperature Current
Fail-safe [+ (<] .
J c = o) mA
1000 F 2000 |5
FS: Not used v %[ Sewp | &
Parameter
Gain: 160,00 pAC
Offset  400mA
Limits
( Set number of ports like connected device ) [F] Support proprietary PIF cable -200°C =0.8mA OmA =-25.0°C
100.0°C =20mA 20mA=100.0°C
[£] Auto apply [ oK J[ Aely ][ Concel ]
Auto apply [
Fig. 24 Configurations menu Device (PIF) Fig. 25 Setup
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9.3.1 Special Settings for thermolMAGER TIM 41

When using the thermolMAGER TIM 41 camera,
an important additional setting must be made
for autonomous operation. When all the configu-
rations have been made, it is important to write
them to the device. This is done in the menu
under Devices and Set configuration to

device.

If the device is reconnected to a PC after au-
tonomous operation and the settings are to be
transferred from the device to the software, this
is done in the menu under Devices and Get
configuration from device.

fin ¢ Bl <]

TIM 41(#21024284) (192.168.0.101 : 50101)

Devices I Toocls  Help

Refresh flag F5

Enable Ethernet
Ethernet settings (TCP/IP) ...

Set configuration to device

Get configuration from device

Fig. 26 Set configuration to device

If the device is reconnected to a PC after autonomous operation and the settings are to be transferred from the
device to the software, this is done in the menu under Devices and Get configuration from device.

> Anarrow marked in red % means that the configuration is different between the camera and the software.
1 As soon as the configuration is loaded into the device, the arrow appears in blue & .

In general these are all the settings that must be set in the TIM Connect software in order to operate the device
autonomously. You can now close the software and then disconnect the USB cable. In order to start up the de-
vice autonomously, a 5 - 30 V power supply must be connected to the terminal block. Now the used input/output
has to be connected. The resulting value can be displayed for example on a multimeter, see Fig. 25.

When using this variant, it can last for about half a minute until the device is ready for use in autonomous mode.
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H Power supply
TIM 8 / TIM 41 PIF cable

TT“T

Terminal
block

z i 0/4-20 mA
Multimeter

Fig. 27 Electrical installation for autonomous operation of thermoMETER TIM 8 | thermolMAGER TIM 41
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- Up to 9 measure areas (for TIM 8 with firmware 3013 or higher) and up to 3 measure areas

- Autonomous operation also works via the industrial/stackable PIF of the thermoMETER TIM 8 / ther-
1 molMAGER 41. The device is powered by the power supply of the PIF.

(TIM 41) can be output autonomously. The prerequisite in this respect with the TIM 8 is the use of

three stackable PIFs.

- Three analog outputs are possible per stackable PIF. The response time is 20 ms for TIM 8 and

640 ms for TIM 41.

Note: Several measuring areas can be combined into one measuring area via a so-called super

area.

- Autonomous mode cannot be set using the Main measure area function (configuration menu
device (PIF). To output a measure area autonomously, the function Measure area must be used.

Analog OQutputs (1) | +

AD:

Mot used
Digital O Main measure area
1easue area

thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41
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9.3.2 Hot-/Coldspot Function in Autonomous Operation

The setting for a hot- or coldspot in autonomous mode differs from the general procedure. It is not enough to
mark a measuring area as hot- or coldspot. Instead, a User defined rectangle must be selected under
the tab measure areas of the configuration dialog. In addition, under Mode, you must set whether the
maximum (for hotspot) or minimum (for coldspot) should be output.

|General || Measure areas § Temp. profiles I Temp/Time diagram I Device I Device (PIF) | Recording | Playing ‘

[Area1<Main> | Measure area Labeinimage
(Measure area) Name: Area 1 ] Name
Add Shape: User def. rectangle ~ || [F] Mode
(Cakculated area) Mode: Maximum - | O Value

two lines

Fig. 28 Setting a hotspot for autonomous operation

For a hot- or coldspot output in the full field of view of the cam-
era, the user defined rectangle must also fill out this size.

Note: Predefined Layout in the software available under
Tools and Layouts:TIM 8 Hot spot autonomous Or
TIM 41 Hot spot autonomous.

2]
o
21

Fig. 29 Measure area over entire field
of view
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9.4 Ethernet thermoMETER TIM 8 / thermolMAGER TIM 41

The thermoMETER TIM 8 / thermolMAGER TIM 41 has a direct Ethernet interface. The advantage is cable
lengths of up to 100 m. For example, a switch can be used to extend the distances.
The associated Ethernet cable (Order No.: TM-ETCx-TIM8) must be ordered separately. Ethernet is supported

from software version Rel. 3.2.3020.0 and firmware 3008.
Using the Ethernet connection, the device must be supplied with power. This can be done either via:
- the internal PIF cable via the terminal block (5 - 30 V),
- via the stackable PIF (5 - 25V, Order No.: TM-PIFCx-TIM8) or
- via PoE (Power over Ethernet).
*  For the PoE variant, a PoE adapter (Order No.: TM-ETPOEC1-TIM8) and a PoE injector (Order No.: TM-
POE-TIM) or PoE switch (e.g. Netgear GS110TP) are also required.

h Power supply

Internal PIF cable

TIM 8/TIM 41

Terminal

Ethernet block

Ethernet

Power supplr

Stackable PIF
TIM 8/TIM 41

Power supply

@ e A —vae  PC
Ethernet Ethernet

PoE adapter PoE injector or
PoE switch

Fig. 30 Possibilities of power supply for thermoMETER TIM 8 | thermolIMAGER TIM 41 via Ethernet connection
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9.4.1 Ethernet Setup (Point-to-Point-Connection)

After connecting the Ethernet cable to the camera and the PC, the first thing you need to do is to make the
network settings on the PC.

The devices are delivered with the following factory settings:
1 IP address camera: 192.168.0.101

IP address PC: 192.168.0.100

Port number: 50101

E3 To do this, goto Control Panel and openthe Network and Sharing Center.
E3 GoonLaN connection.

View your basic network information and set up connections

el e

your computer your current network Internet

View your active networks Connect or disconnect

@ your current network Access type: | ocal and Internet
Domain network Connections: {8l Local Area Connection
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— = =
Local Area Connection StatS @ Local Area Connection Properies TR Internet Protocol Version 4 (TCP/IPv4) Properties @[ =]
— —
General Netwerking General
Connect using: You can get IP settings assigned automatically if your network supports
Connection ‘ & Intel(R) PRO/1000 MT Network Connection ‘ this capability. Otherwise, you need to ask your network administrator
IPv4 Connectivity: Internet = for the appropriate IP settings.
1PV6 Connectivity: No network access i
Meda State: Enabled | || This connecton uses the folowing tems Q Obtain an [P address automaticaly
Duration: 00:05:48 8 Clent for Microsoh Networks @ Use the following IP address:
Speed: 1.0 Ghps ¥ J8)QoS Packet Scheduler 1P address: 192.168 . 0 . 100
™ QFle and Pnrter Shanng for meﬂ Networks —
 Protoco Subnet mask: 255 .255.255. 0
Default gateway:
2 poIogy 2
ayer
Activity ) - Lk Topology D‘!wve'y Responder Obtain DNS server address automatically

@ Use the following DNS server addresses:

st — BGH oo (et [ (gt}

-ﬁg Descrption Preferred DNS server:
Bytes %057 | ».9% e s et o ok poves vemrtoson emate IS senver
across diverse interconnected n:twofks.
@Hwﬁes @m [ = ] [ validate settings upon exit e
[ ok J[ coce ]
Glose ——
E3 Click on Properties. E3 Mark Internet proto- [E4 Inthe register card General
col Version 4 (TCP/ enable the checkbox Use the
Ipv4) and goto Proper- following IP address.

ties again. i
E3 Now enter a user defined

IP address for your PC
(192.168.0.100).

This must be identical to the address
set in the TIM Connect software.

E3 Then close the windows with OX.

The network settings on the PC are complete.
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E3 Now start the TIM Connect software and activate the Eth-
ernet function.

E3 To do this, go to the menu Devices and Enable Eth-
ernet.

Tools  Help

Refresh flag

Enable Ethernet
a% Ethernet settings (TCP/IP] ...

1 When a Firewall windows appears, make sure to select all three network parts (domain, private, public) in order to allow the

communication with the device.

Windows Defender Firewall has blocked some features of this

app

Windows Defender Firewall has blocked some features of USB IR Camera Software (.NET 4.5,
v120) on all public, private and domain networks,

. Name: USB IR Camera Software (.NET 4.5, v120)
Publisher: Unknown
Path: C:\program files (x86) \pix connectmager.exe

Allow USB IR Camera Software (.NET 4.5, v120) to communicate on these networks:
[&] Domain networks, such as a workplace network

[Aprivate networks, such as my home or work network

[F]Public networks, such as those in airports and coffee shops (not recommended
because these networks often have little or no security)

What are the risks of allowing an app through a firewall?

&) Alow access Cancel

[ » Control Panel » System and Security » Windows Firewall » Allowed Programs [ #3][ search cd

View Tools Help

Allow programs to communicate through Windows Firewall
To add, change, or remove allowed programs and ports, click Change settings.

What are the risks of allowing a program to communicate? %) Change settings

Allowed programs and features:
Name Domain Home/Work (Private) ~ Public
Remote Volume Management o O
[ Routing and Remote Access O o O
[Secure Socket Tunneling Protocol m] =] O
CISNMP Trap m] [m} |
Teamviewer Remote Control Application o O
Teamviewer Remote Control Service (m] ]
[ USB IR Camera Software (.NET 2.0, v30) |H
W u} o
Mvncviewer.exe (] a
V&T Netzwerkgerite verwalten O [m]
&T USB Redirector [m} O
[/ W&LT USB Redirector m| 0 S

Allow another program...

*  The approval of programs can also be activated afterwards in the Windows Firewall settings of the PC (under windows Fire-
1 wallandAllow a Program or feature through Windows Firewall).
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Software TIM Connect

The device is now ready for the Ethernet connection and is listed in
the menu under Devices. The camera is identified by a network icon
and the network address and port number.

E3 Select the device.

A connection to the device is established and the temperature mea-
surement can begin.

E3 To change the address settings, go to Devices and Ethernet
settings (TCP/IP).

The address for the device is assigned under Device address. This
must have a different address (last block) to the other participant
(e.g., PC) (send to address (local computer)).

° ltis important that the network part (first three blocks) must be
1 identical for both addresses. The address range of the individu-
al blocks can be between 0 and 255.

Devices | Tools  Help

Refresh flag F5

Enable Ethernet

Egﬁ Ethernet settings (TCP/IP) ...
Egﬁ X410 (#21024284) (192.168.0.101 : 50101)

CP/IP Settings — (|
Settings in cumently connected device

Device address (Xi410 #21024284): 192 .168 . 0 . 101
152 .168. 0 . 100
25.255.55. 0

50101 =

Send to address (local computer):
Subnet mask:
Port number:

auto assign port number

Listen on port number: 50101 =

Cance

Additionally, a separate port number must be configured. The selected number can be between 1 and 65535.
The option auto assign port number assigns a port number automatically.

If several cameras with different port numbers are connected and a specific camera is to be communicated with, the corresponding

camera can be determined via Listen on port number.

assigned.

thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41
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Software TIM Connect

When using multiple TIM 8 / TIM 41 cameras in a network, the data rate must be considered:

1 - Switch with 100 Mbps/s: approx. 17 devices (TIM 8), approx. 2 devices (TIM 41 with 25 Hz)
- Switch with 1000 Mbps/s: approx. 170 devices (TIM 8), approx. 26 devices (TIM 41 with 25 Hz)
In addition to the data rate also make sure the power performance of the PC is high enough. Each
device used requires its own instance.

9.5 Basic Features of Software TIM Connect

Extensive infrared camera software

2 LabVIEW

My
Wf"n;g:-"”
| o
. ‘?
". ;, Windows Vista
Windows 7

No restrictions in licensing

Modern software with intuitive user interface

Remote control of camera via software

Display of multiple camera images in different windows
Compatible with Windows XP, Vista, 7, 8, 10 sowie LabVIEW

High level of individualization for customer specific display

Various language option including a translation tool

Temperature display in °C or °F

Different layout options for an individual setup (arrangement of windows,
toolbar)

Range of individual measurement parameter fitting for each application
Adaption of thermal image (mirror, rotate)

Individual start options (full screen, hidden, etc.)

thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41
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Software TIM Connect

Video recording and snapshot function (IR or BI-SPECTRAL)

———— =i - Recording of video sequences and detailed frames for further analysis or
documentation

- Adjustment of recording frequency to reduce data volume

- Display of snapshot history for immediate analysis

Extensive online and offline data analysis

T T — - Analysis supported by measurement fields, hot and cold spot searching,
W o image subtraction

- Real time temperature information within main window as digital or
graphic display (line profile, temperature time diagram)

- Slow motion repeat of radiometric files and analysis without camera being
connected

- Editing of sequences such as cutting and saving of individual images

- Various color palettes to highlight thermal contrasts

=X E § EY

o

Automatic process control

- Individual setup of alarm levels depending on the process

- Definition of visual or acoustic alarms and analog data output

- Analog and digital signal input (process parameter)

- External communication of software via Comports, DLL and LabVIEW
- Adjustment of thermal image via reference values
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Software TIM Connect

Temperature data analysis and documentation

i — = - Triggered data collection
R - Radiometric video sequences (*.ravi) radiometric snapshots (*.jpg, * tiff)

- Text files including temp. information for analysis in Excel (*.csy, *.dat)

- Data with color information for standard programmes such as Photoshop
or Windows Media Player (*.avi, *.jpg, * tiff)

- Data transfer in real time to other software programmes via LabVIEW, DLL
or Comport interfaces
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Basics of Infrared Thermometry
10. Basics of Infrared Thermometry

10.1 Introduction

Depending on the temperature each object emits a certain amount of infrared radiation. A change in the tem-
perature of the object is accompanied by a change in the intensity of the radiation.

Searching for new optical material William Herschel by chance found the infrared radiation in 1800.

He blackened the peak of a sensitive mercury thermometer. This thermometer, a glass prism that led sun rays
onto a table made his measuring arrangement.

With this, he tested the heating of different colors of the spectrum. Slowly moving the peak of the blackened
thermometer through the colors of the spectrum, he noticed the increasing temperature from violet to red.

The temperature rose even more in the area behind the red end of the spectrum. Finally he found the
maximum temperature far behind the red area.

Nowadays this area is called infrared wavelength area.
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Basics of Infrared Thermometry

For the measurement of “thermal radiation” infrared thermometry uses a wave-length ranging between 1 u
and 20 um.

The intensity of the emitted radiation depends on the material. This material contingent constant is described
with the help of the emissivity which is a known value for most materials, see 11.

Infrared thermometers are optoelectronic sensors. They calculate the surface temperature on the basis of the
emitted infrared radiation from an object. The most important feature of infrared thermometers is that they en-
able the user to measure objects contactless. Consequently, these products help to measure the temperature
of inaccessible or moving objects without difficulties.

Infrared thermometers basically consist of the following components:
- Lens

- Spectral filter

- Detector (sensor)

- Electronics (amplifier/ linearization/ signal processing)

X-rays Ullravuo!ell] Infrared Radio

1nm 400 nm 1um 1mm Wavelengt

m

400 nm 780 nm 14puym Wavelength

Fig. 32 The electromagnetic spectrum and the area used for temperature measurement

The specifications of the lens decisively determine the optical path of the infrared thermometer, which is char-
acterized by the ratio Distance to Spot size. The spectral filter selects the wavelength range, which is relevant
for the temperature measurement. The detector in cooperation with the processing electronics transforms the
emitted infrared radiation into electrical signals.
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Basics of Infrared Thermometry

- H[e2sc ]
Object Lens Sensor Electronics Display

Infrared system
Fig. 33 Optical path

The advantages of non-contact temperature measurement are clear - it supports:
- temperature measurements of moving or overheated

- objects and of objects in hazardous surroundings

- very fast response and exposure times

- measurement without inter-reaction, no influence on the

- measuring object

- non-destructive measurement

- long lasting measurement, no mechanical wear

Fig. 34 TIM with tablet PC
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Basics of Infrared Thermometry

10.2 Application Examples

Monitoring of electronic  Electronic development

cabinets

Monitoring of cables Development of me-
chanical parts

thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41

Process control extrud-
ing plastic parts

Process control at calen-

Development of elec-
tronic components

Process control in solar
cell production
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Emissivity
11. Emissivity

11.1 Definition
The intensity of infrared radiation, which is emitted by each body, depends on the temperature as well as on
the radiation features of the surface material of the measuring object. The emissivity (e — Epsilon) is used as
a material constant factor to describe the ability of the body to emit infrared energy. It can range between 0
and 100 %. A “blackbody” is the ideal radiation source with an emissivity of 1.0 whereas a mirror shows an
emissivity of 0.1.
If the emissivity chosen is too high, the infrared thermometer may display a temperature value which is much
lower than the real temperature — assuming the measuring object is warmer than its surroundings. A low
emissivity (reflective surfaces) carries the risk of inaccurate measuring results by interfering infrared radiation
emitted by background objects (flames, heating systems, chamottes). To minimize measuring errors in such
cases, the handling should be performed very carefully and the unit should be protected against reflecting
radiation sources.

\ X F //

Radiation from

__- ambient

7 e
Object | / / \

. /;oﬁ”’

Fig. 35 Composition of IR radiation

I IR radiation p Reflection
e+p+1=1

¢ Emission T Transmission
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0 2 4 6 8 10

Wellenlange in um

Fig. 36 Spectral emissivity of several materials

1 Enamel 3 Concrete

2 Plaster 4 Chamotte
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11.2  Determination of Unknown Emissivity

There are 3 methods:

1

First of all, determine the current temperature of the measuring object with a thermocouple or
contact sensor. The second step is to measure the temperature with the infrared thermometer
and modify the emissivity until the displayed measuring value corresponds to the current tem-
perature.

If you monitor temperatures of up to 380 °C you may place a special plastic sticker (Part number:
TM-ED-LS emissivity dots) onto the measuring object, which covers it completely.

Fig. 37 Plastic sticker at metal surface

E3 Now set the emissivity to 0.95 and take the temperature of the sticker.

E3 Afterwards, determine the temperature of the adjacent area on the measuring object and
adjust the emissivity according to the value of the temperature of the sticker.

E3 Cover a part of the surface of the measuring object with a black, flat paint with an emissivity
of 0.98.

E3 Adjust the emissivity of your infrared thermometer to 0.98 and take the temperature of the
colored surface.

thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41 Page 61



Emissivity

(pr— poepmii }

Fig. 38 Shiny metal surface Fig. 39 Blackened metal surface

E3 Afterwards, determine the temperature of a directly adjacent area and modify the emissivity
until the measured value corresponds to the temperature of the colored surface.

On all three methods the object temperature must be different from ambient temperature.

1
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11.3  Characteristic Emissivity

In the case that none of the methods mentioned above help to determine the emissivity you may use the
emissivity tables, see A 3, see A 4. These are only average values. The actual emissivity of a material de-
pends on the following factors:

- Temperature

- Measuring angle

- Geometry of the surface (smooth, convex, concave)

- Thickness of the material

- Constitution of the surface (polished, oxidized, rough, sandblast)

- Spectral range of the measurement

Transmissivity (e.g. with thin films)

Fixed radiometric values
Emissivity: 1.000 =

Transmissivity: 1000 1=
{IR-window compansation) '

Ambient temperature: [ [23.0 2

Fig. 40 Adjustment of the emissivity in the software TIM Connect under the menu item Tools | Configuration /
Device
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12. Disclaimer

All components of the device have been checked and tested for functionality in the factory. However, should
any defects occur despite careful quality control, these shall be reported immediately to MICRO-EPSILON or
to your distributor / retailer.

MICRO-EPSILON undertakes no liability whatsoever for damage, loss or costs caused by or related in any

way to the product, in particular consequential damage,

e.g., due to

- non-observance of these instructions/this manual,

- improper use or improper handling (in particular due to improper installation, commissioning, operation
and maintenance) of the product,

- repairs or modifications by third parties,

- the use of force or other handling by unqualified persons.

This limitation of liability also applies to defects resulting from normal wear and tear (e.g., to wearing parts)
and in the event of non-compliance with the specified maintenance intervals (if applicable).

MICRO-EPSILON is exclusively responsible for repairs. It is not permitted to make unauthorized structural
and / or technical modifications or alterations to the product. In the interest of further development, MICRO-
EPSILON reserves the right to modify the design.

In addition, the General Terms of Business of MICRO-EPSILON shall apply, which can be accessed under
Legal details | Micro-Epsilon https://www.micro-epsilon.com/impressum/.

For translations into other languages, the German version shall prevail.
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Service, Repair
13. Service, Repair

If the camera is defective, please send us the affected parts for
repair or exchange.

If the cause of a fault cannot be clearly identified, please send
the entire measuring system to:

For customers in USA applies:

Send the affected parts or the entire measuring system back to:

For customers in Canada or South America applies:
Please contact your local distributor.

thermoMETER TIM 8 / thermolMAGER TIM 40 / TIM 41

MICRO-EPSILON MESSTECHNIK

GmbH & Co. KG
Kénigbacher Str. 15

94496 Ortenburg / Germany
Tel. +49 (0) 8542 / 168-0
Fax +49 (0) 8542 / 168-90
info@micro-epsilon.de
www.micro-epsilon.com

MICRO-EPSILON USA
8120 Brownleigh Dr.
Raleigh, NC 27617 /USA
Tel. +1 919/ 787-9707

Fax +1 919 /787-9706
me-usa@micro-epsilon.com
www.micro-epsilon.com
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Decommissioning, Disposal

14. Decommissioning, Disposal

In order to avoid the release of environmentally harmful substances and to ensure the reuse of valuable raw materials, we draw your

attention to the following regulations and obligations:

- Remove all cables from the sensor and/or controller.

- Dispose of the sensor and/or the controller, its components and accessories, as well as the packaging materials in compliance with
the applicable country-specific waste treatment and disposal regulations of the region of use.

- You are obliged to comply with all relevant national laws and regulations.

For Germany / the EU, the following (disposal) instructions apply in particular:
- Waste equipment marked with a crossed garbage can must not be disposed of with normal industrial waste

(e.g. residual waste can or the yellow recycling bin) and must be disposed of separately. This avoids hazards to
the environment due to incorrect disposal and ensures proper recycling of the old appliances.

- Alist of national laws and contacts in the EU member states can be found at
https://ec.europa.eu/environment/topics/waste-and-recycling/waste-electrical-and-electronic-equipment-weee_en.
Here you can inform yourself about the respective national collection and return points.

- Old devices can also be returned for disposal to MICRO-EPSILON at the address given in the imprint at https://www.micro-epsilon.
de/impressum/.

- We would like to point out that you are responsible for deleting the measurement-specific and personal data on the old devices to
be disposed of.

- Under the registration number WEEE-Reg.-Nr. DE28605721, we are registered at the foundation Elekiro-Altgerate Register, Nordost-
park 72, 90411 Nuremberg, as a manufacturer of electrical and/or electronic equipment.
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Appendix | Accessories
Appendix

A1 Accessories

A1l Air Purge Laminar

The lens must be kept clean at all times from dust, smoke, fumes and other contaminants in order to avoid
reading errors. These effects can be reduced by using an air purge TM-APL.

Make sure to use oil-free, technically clean air, only.

l The needed amount of air (approx. 2 ... 10 I/min.) depends on the application and the installation condi-
tions on-site.

The laminar air purge has a Si-protective window. Typical transmission value: 0.82 (deviations possible)
The corresponding mounting bracket TM-APLAB-TIM8/40 is mandatory.

Material: Anodized aluminum, weight: 218 g / 494 g with mounting bracket

Ambient temperature: 0 ... +80 °C (T, camera: 0 ... +50 °C); with water cooled housing up to +250 °C

Air flow
The air purge can be mounted in four different positions.

1

The direction of the airflow must always be clear.

Fig. 41 Directions of airflow at different mounting positions
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Fig. 42 Laminar air purge with Sl protective window TM-APL-TIM8/40, dimensions in mm
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Fig. 43 Laminar air purge with Sl protective window TM-APL and mounting bracket TM-APLAB,
dimensions in mm
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Fig. 44 Mounting bracket TM-APLAB, dimensions in mm
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A1l1.2 Water Cooling

The IR camera is for application at ambient temperatures up to 50 °C. For applications at higher ambient
temperatures we recommend the usage of the optional water cooled housing (operating temperature up to
250 °C) and the optional high temperature cable (operating temperature up to 250 °C).

> Then using water cooling, a corresponding mounting kit (TM-WAKx-TIMxx) is required.
l Water flow rate: approx. 2 I/ min (cooling water temperature should not exceed 30 °C)

AD 8 mm

60

- -

Fig. 45 Water cooling TM-W-TIM8/4 and mounting kit TM-WAK1-TIMxx, dimensions in mm
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" -3

Fig. 46 Shutter for water cooling TM-SW-TIM8/40, dimensions in mm
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A1.3 Shutter

To protect the optics of the camera, an optional shutter (closing mechanism), can be purchased. It is
equipped with a servomotor that can open and close a mechanical lock as needed. The special feature of the
shutter is not only the opening and closing, but also the complete seal in the closed state. This ensures that
the shutter is completely closed and no dirt can get on the optics.

The shutter has a 100 ms fast-closing mode.

1 Complete seal when closed.

Includes a control box for connections.

Shutter can be used in combination with Process Interface (PIF).

The corresponding mounting bracket (TM-APLAB-TIM8/40) is mandatory.

Material: Stainless steel

Weight: 550 g / 826 g Shutter with mounting bracket

When using more than one shutter and the opening / closing of the shutter should be simultaneously,
the switch S4 on one control box must be set to mA and the others to mV, see Fig. 49.

Ambient temperature: 0 ... +60 °C (T, .~ camera: 0 ... +50 °C); with water cooled housing up to
+250 °C

mb
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1

57

Fig. 47 Shutter TM-S-TIM8/40 with mounting bracket TM-APLAB-TIM8/40, dimensions in mm
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Fig. 48 Shutter TM-S-TIM8/40, dimensions in mm
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Fig. 49 Control box of shutter, dimensions, see Fig. 11

Power supply 12-24V

Upper terminal screw Connection for Process Interface (PIF)

Switch for different operation S1: Switching between switch operation and pulse operation
modes: S2: Activation/deactivation of fast-closing mode

S3: Only for factory calibration (switch must be at normal)
S4: Switching between mV or mA input

Lower screw terminal Connection for power supply, inputs (Start/Stop signal) and motor
Inputs (Start/Stop signal, max. IN 1: Trigger input for normal operation (S1)
24V, input is active LOW (open

IN 2: Currently no usage
IN 3: Trigger input for fast-closing mode (S2)

input = HIGH))
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A4 Combination of Air Purge, Water Cooling and Shutter

It is possible to combine all three components (air purge, water cooling and shutter) with each other. It should
be noted that there are differences between the TIM 8 and TIM 40. Various mounting kits TM-WAKx-TIMxx are

available in combination with water cooling. The mounting bracket is always required for the air purge

TM-APLAB. For water cooling TM-W-TIM8/4, the mounting bracket is included and does not have to be or-

dered separately.

thermoMETER TIM 8 / thermolIMAGER TIM 40 / TIM 41

Article number

g % § g © © g g
s || = |2 8 =| & 2|2 = =
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32 2 EE % % %
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Combinations £ E = = = = = = £ 2

Air purge \ v

Water cooling TIM 8 \ \

Water cooling TIM 40 | \

Shutter \ v

Ai t ling TIM

ir purge and water ccoling 8 v v v

Air purge and water ccoling TIM 40 \) \) v

Air purge and shutter | | \

Water cooling and shutter TIM 8 \ \ \

Water cooling and shutter TIM 40 \ \ v

Air purge, water cooling and shutter

TIM 8 v v v v

Air purge, water cooling and shutter

TIM 40 v v v v
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18

Fig. 50 Air purge TM-APL, water cooling TM-W-TIM8/40, shutter TM-SW-TIM8/40 and appropriate mounting kit
TIM-WAKx-TIMxx, dimensions in mm

Components

- Air purge

- Water cooling
- Shutter

- Mounting kit
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186,5 .

1195

Fig. 51 Air purge TM-APL, water cooling TM-W-TIM8/40 and appropriate mounting kit TIM-WAKx-TIMxx, dimen-

sions in mm

Components

- Air purge

- Water cooling
- Mounting kit
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167.5

Fig. 52 Water cooling TM-W-TIM8/40L, shutter TM-SW-TIM8/40 and appropriate mounting kit TIM-WAKXx-TIMxx,
dimensions in mm

Components

- Water cooling

- Shutter

- Mounting kit
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|57

Fig. 563 Air purge TM-APL-TIM8/40 with mounting bracket TM-FB-TIM8/40 and shutter TM-S-TIM8/40, dimen-

sions in mm
Components

- Air purge

- Mounting bracket
- Shutter
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A1.5 Outdoor Protective Housing

The infrared camera TIM can also be used for outdoor applications by using the outdoor protective
1 housing TM-OPH24-TIM8/40.
In addition, the industrial or stackable PIF TM-CJAPIF-TIM (thermolMAGER TIM 40) or TM-PIFCx-TIM8

(thermoMETER TIM 8 / thermolMAGER TIM 41) can be installed as an accessory without housing and a
USB Server TM-USBSGB-TIM.

Fig. 54 Outdoor protective housing for TIM camera
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A1.6 Hardware and Software
TM-NETBox-TIM Miniature PC for

standalone installa-
() - E:_MTETL tion of TIM systems

Ethernet Kommunikation iber Netzwerk

-~

848V0C or Power over Etnernt (o)

o< g

!
%

TM-USBSII-TIM po, USB server for
I mciiin

cable extension via
P -§- = - Ethernet
W
| A

A2 Factory Settings

The devices have following presettings at time of delivery:

Temperature range -20...100 °C
Emissivity 1.000
Process interface (PIF) inactive

Interprocess Communication (IPC) |inactive

Measurement function Rectangle measure area
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A3 Emissivity Table Metals
Material Typical Emissivity
Spectral response 1.0 um 1.6 um 5.1 ym 8-14 um
Aluminum Non oxidized 0.1-0.2 0.02-0.2 0.02-0.2 0.02-0.1
Polished 0.1-0.2 0.02- 0.1 0.02- 0.1 0.02 - 0.1
Roughened 0.2-0.8 0.2-0.6 0.1-04 0.1-0.3
Oxidized 0.4 0.4 0.2-04 0.2-04
Brass Polished 0.35 0.01-0.05 0.01-0.05 0.01-0.05
Roughened 0.65 0.4 0.3 0.3
Oxidized 0.6 0.6 0.5 0.5
Copper Polished 0.05 0.03 0.03 0.03
Roughened 0.05-0.2 0.05-0.2 0.05-0.15 0.05- 0.1
Oxidized 0.2-0.8 0.2-0.9 0.5-0.8 04-0.8
Chrome 0.4 0.4 0.03-0.3 0.02-0.2
Gold 0.3 0.01-041 0.01-041 0.01-0.1
Haynes Alloy 0.5-0.9 0.6-0.9 0.3-0.8 0.3-0.8
Inconel Electro 0.2-05 0.25 0.15 0.15
polished
Sandblast 0.3-04 0.3-0.6 0.3-0.6 0.3-0.6
Oxidized 0.4-0.9 0.6-0.9 0.6-0.9 0.7 - 0.95
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Material Typical Emissivity
Spectral response 1.0 um 1.6 um 5.1 ym 8-14 um
Iron Non oxidized 0.35 0.1-0.3 0.05-0.25 0.05-0.2
Rusted 0.6-0.9 05-0.8 05-0.7
Oxidized 0.7-0.9 0.5-0.9 0.6-0.9 0.5-0.9
Forget, blunt 0.9 0.9 0.9 0.9
Molten 0.35 0.4-0.6
Iron, casted Non oxidized 0.35 0.3 0.25 0.2
Oxidized 0.9 0.7-0.9 0.65-0.95 0.6 - 0.95
Lead Polished 0.35 0.05-0.2 0.05-0.2 0.05- 0.1
Roughened 0.65 0.6 0.4 0.4
Oxidized 0.3-0.7 0.2-0.7 0.2-0.6
Magnesium 0.3-0.8 0.05-0.3 0.03-0.15 0.02 - 0.1
Mercury 0.05-0.15 0.05-0.15 0.05-0.15
Molybdenum Non oxidized 0.25-0.35 0.1-0.3 0.1-0.15 0.1
Oxidized 0.5-0.9 0.4-09 0.3-0.7 0.2-0.6
Monel (Ni-CU) 0.3 0.2-0.6 0.1-0.5 0.1-0.14
Nickel Electrolytic 0.2-04 0.1-0.3 0.1-0.15 0.05-0.15
Oxidized 0.8-0.9 0.4-0.7 0.3-0.6 0.2-05
Platinum Black 0.95 0.9 0.9
Silver 0.04 0.02 0.02 0.02
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Material Typical Emissivity
Spectral response 1.0 um 1.6 yum 5.1 ym 8-14um
Steel Polished plate 0.35 0.25 0.1 0.1
Rustless 0.35 02-09 0.15-0.8 0.1-0.8
Heavy plate 05-0.7 0.4-0.6
Cold-rolled 0.8-0.9 0.8-09 0.8-0.9 0.7-0.9
Oxidized 0.8-09 09-09 0.7-0.9 0.7-0.9
Tin Non oxidized 0.25 0.1-03 0.05 0.05
Titanium Polished 0.5-0.75 0.3-05 0.1-0.3 0.05-0.2
Oxidized 0.6-0.8 05-0.7 0.5-0.6
Wolfram Polished 0.35-0.4 0.1-03 0.05-0.25 0.03-0.1
Zinc Polished 0.5 0.05 0.03 0.02
Oxidized 0.6 0.15 0.1 0.1
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A4 Emissivity Table Non Metals
Material Typical Emissivity
Spectral response 1.0 ym 2.3 um 5.1 um 8-14 um
Asbest 0.9 0.8 0.9 0.95
Asphalt 0.95 0.95
Basalt 0.7 0.7
Carbon Non oxidized 0.8-0.9 0.8-0.9 0.8-0.9
Graphite 0.8-0.9 0.7-0.9 0.7-0.9
Carborundum 0.4 0.8-0.95 0.8-0.95 0.95
Cement 0.65 0.9 0.9 0.95
Ceramic 0.65 0.9 0.9 0.95
Glass Plate 0.2 0.98 0.85
Melt 04-0.9 0.9
Grit 0.95 0.95
Gypsum 0.4-0.97 0.8-0.95
Ice 0.98
Limestone 0.4-0.98 0.98
Paint Non alcaline 0.9-0.95
Paper Any color 0.95 0.95
Plastic > 50 um Non transparent 0.95 0.95
Rubber 0.9 0.95
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Material Typical Emissivity

Spectral response 1.0 ym 2.3 um 51 um 8-14 um
Sand 0.9 0.95

Snow 0.9

Soil 0.9-0.98
Textiles 0.95 0.95
Water 0.93
Wood Natural 0.9-0.95 0.9-0.95
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A5 Industrial Process Interface for thermoMETER TIM 8 (Optional)

For use in industrial environment the industrial process interface with 500 V AC . isolation voltage between
thermoMETER TIM 8 and process is available (connection box with IP65, 5 m, 10 m or 20 m standard or high
temperature cable for camera connection, terminal block for process integration), see A 12.

Color Assignment
» Green RS485 B
000000 ® Yellow RS485 A

sgleslzg ’ } e White 12V
ﬂgg;ggs ks g Brown GND

Shield GND

Fig. 55 Connections of the industrial Process Interfaces for thermoMETER TIM 8
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The industrial process interface provides the following inputs and outputs:

Designation | Description max. range ' / status
INPUT 1/2/3 | Analog- or digital input 1, 2, 3 0-10V?
AO 1/2/3 Analog output 1,2 and 3 0-10V
Alarm output 1,2 and 3 0/4 - 20 mA
DO 1/2/3 Relais output 1, 2 and 33 open/ closed (red LED on)/ 0 ... 30 V, 400 mA
FS Fail-safe-relay open/ closed (green LED on)/ 0 ... 30 V, 400 mA

The industrial PIF has a maximum of 3 analog outputs. To use more outputs, you can cascade up to
1 three PIFs, allowing you to use up to 9 analog or alarm outputs in total.

1) Depending on supply voltage; for 0 - 10 V on the AO the PIF has to be powered with min. 12 V.
2) The Al is designed for max. 24 V, the voltage level above 10 V is not interpreted.
3) Active if AO1, 2 or 3 is/ are programmed as alarm output.
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PIF cable

5..24VDC

Fig. 56 Connection of 3 industrial PIFs via RS485
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Appendix | Industrial Process Interface for thermoMETER TIM 8 (Optional)

*  Each stackable industrial PIF must have its own RS485 address. The address must be set directly on
1 the board and in the software. For the PIF which is the furthest away the 120R switch (TERM.- Termina-
tion) has to be set.

*  The RS485 interface is defined for a length of 500 m.

1

The process interface has an integrated fail-safe mode. This allows to control conditions like interruption of
cables, shut-down of the software etc. and to give out these conditions as an alarm.

Controlled conditions on camera Standard Process interface Industrial Process interface

and software TM-PIF-TIM8 TM-PIFCBx-TIM8

Interruption USB cable to camera \ \

Interruption data cable camera - \ \

PIF

Interruption power supply PIF | \

Shut-down of TIM Connect \ v

software

Crash of TIM Connect software - v

Fail-Safe-Output 0V at analog output (AO) Open contact
(fail-safe-relay)/ green LED off
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A6 Industrial Process Interface for thermolMAGER TIM 40 (Optional)

For use in industrial environment the industrial process interface with 500 V AC,,, . isolation voltage between
thermolMAGER TIM 40 and process is available (connection box with IP 65, 5 m, 10 m or 20 m standard or
high temperature cable for camera connection, terminal block for process integration, see A 12.

Pin assignment
Color Designation
90000000
Grey Interrupt
% Green SCL (I2C)
E Yellow SCL (I’C)
White 33V
Brown GND
Shield GND

Fig. 57 Connections of the industrial Process Interfaces for thermolIMAGER TIM 40
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The industrial process interface provides the following inputs and outputs:

Designation |Description max. range " / status
AIN1/2 Analog input 1 and 2 0-10V?2
DIN1 Digital input 24V
(Low-active = 0...0.6 V)
AO1/2/3 Analog output 1, 2 and 3 0/4 - 20 mA
Alarm output 1, 2 and 3 0/4 - 20 mA
DO1/2/3 Relay output 1,2 and 39 open/ closed (red LED on)/ 0 ... 30 V, 400 mA
FS Fail-safe-relay open/ closed (green LED on)/ 0 ... 30 V, 400 mA

1) Depending on supply voltage; for 0 - 20 mA on the AO the PIF has to be powered with min. 5V <
(1.5 + working resistance * 0.021) < 24 V. Working resistance = Load bzw. Measuring resistance;
Example: R, = 500 Ohm — U__ = 1.5+ 500 * 0.021 = 12,

R g = 100 0hm — U_ =15+ 100*0.021 =3.6V = min. 5V

Load

2) The Al is designed for max. 24 V, the voltage level above 10 V is not interpreted.
3) Active if AO1, 2 or 3 is/ are programmed as alarm output.
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Appendix | Industrial Process Interface for thermolMAGER TIM 40 (Optional)

The alarm output can be configured as a threshold between 0 - 4 mA for no alarm and between
1 10 - 20 mA as alarm. For values outside the respective range, the relay does not switch on the DO.

The process interface has an integrated fail-safe mode. This allows to control conditions like interruption of
cables, shut-down of the software etc. and to give out these conditions as an alarm. The time constant of the
fail-safe is 1.5 seconds.

Controlled conditions on camera Standard Process interface Industrial Process interface

and software TM-PIFCxx-TIM

Interruption USB cable to camera \ A

Interruption data cable camera - \ \

PIF

Interruption power supply PIF \ \

Shut-down of TIM Connect \' V'

software

Crash of TIM Connect software - \'

Fail-Safe-Output 0V at analog output (AO) Open contact
(fail-safe-relay)/ green LED off
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A7 Examples for a Fail-Safe Monitoring with a PLC

PIF terminal box for connecting

:"i—ﬂlDC process cables
m s PLC
Vce
[21 R| | 0V =FS [2]
,’ A/ AnalogIN 1/2 Vce = OK
——— Vce =FS [3]
/4
[3] L ol
4]
151 PC
. - 3 TIM Connect
6] G [71 Fail-Safe status:
Normal: Relay closed LED on
Alarm: Relay open LED off
Fig. 58 Fail-Safe monitoring states
[1] | Breakdown of PIF power supply [4] | Malfunction of camera
[2] | Cable break of fail-safe cable [5] | Breakdown of TIM power supply/ Interruption of USB cable
[3] |Interruption of cable TIM-PIF [6] | Malfunction of TIM Connect software
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Appendix | Examples for a Fail-Safe Monitoring with a PLC

PIF terminal box for connecting

:“i—ﬂIDC process cables
n PLC
. . I Vce
[2] Rl | 0V =FS [2]
R ,’ A/ Analog IN 1/2 Vce = OK
e Vee = FS [3]
/4
[3] L el
~1[4]
[5]
= PC
/_-(: PIX Connect
6] [71 Fail-Safe status:

Normal: Relay closed LED on
Alarm: Relay open LED off

Fig. 59 Fail-Safe monitoring states

[1] | Breakdown of PIF power supply [5] | Malfunction of TIM

[2] | Cable break of fail-safe cable [6] | Breakdown of TIM power supply/ Interruption of USB cable

[3] | Short circuit of fail-safe cable [7] | Malfunction of TIM Connect software

[4] | Interruption of cable TIM-PIF
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A8 USB Cable Extension for thermolMAGER TIM 40

The maximum USB cable length is 20 m. For greater distances between thermolMAGER TIM 40 and com-
puter or for stand-alone solutions the optional USB Server Gigabit is provided:

Network / Internet
24V DC or Power over Ethernet i
~ 4 r—-l |
: Bl PoE E:
(é—- ™ =3 E

Fig. 60 USB-Server Gigabit
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Appendix | A Quick Start for Serial Communication

A9 A Quick Start for Serial Communication
A 9.1 Introduction

One of the feature of the thermolMAGER TIM Connect software contains the possibility to communicate via a serial COM-PORT inter-
face. This can be a physical COM-PORT or a Virtual COM-PORT (VCP). It must be available on the computer where the TIM connect

software is installed.
A9.2 Setup of the Interface

E3 Open the options dialog and enter the tab External Communication to enable the software for the serial communication.

Configuration

o

General | Measure areas | Temp. profiles | Temp./Time diagram | Device | Device (PIF) | Referencing | Recording I Flaying |

IR Image amanging | Alams I Event grabberl Extemal Communication || Bdended Layout

Snapshots / Copy to clipboard I Trig. Recording / Snapshots | Capture Screen | Histogram I Bxtended measuring I Measuring colors |

E3 Select the mode com-Port and choose the appropriate port.

Mode

© Of (@ Connect SDK (IPC) @ COM-Port

COM-Port

Port: Kommunikationsanschluss {COh;H) =
Baud rate: %00 -

Bus address: [7] 1 7 :

E3 Select the baud rate that matches the baud rate of the other communication device.

The other interface parameters are 8 data bits, no parity and one stop bit (8N1). These parameters are used in many other communi-

cation devices too. The other station must support 8 bit data.

E3 Connect the computer with the communication device. If this is a computer too, use a null modem cable.

A9.3 Command List

The command list is provided on the USB stick and the TIM Connect software (Help > SDK).
1 Every command must expire with CR / LF (0x0OD, 0x0A).
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Appendix | A Brief Overview to DLL Communication (IPC)

A10 A Brief Overview to DLL Communication (IPC)

The description of the initialization procedure as well as the necessary command list is provided on the
1 delivered USB stick and in the TIM Connect software under Help > SDK.

2 SDK packages are available. These can be found on the delivered USB stick:
- Connect SDK: requires the TIM Connect software
- Direct SDK: no TIM Connect software required, supports Linux and Windows

The communication to the process imager device is handled by the TIM Connect software (Imager.exe)
only. A dynamic link library (ImagerIPC2.d11) provides the interprocess communication (IPC) for other at-
tached processes. The DLL can be dynamically linked into the secondary application. Or it can be done static
by a lib file too. Both Imager.exe and ImagerIPC2.d11 are designed for Windows Vista/ 7/ 8/ 10 only.
The application must support call-back functions and polling mode.

The ImagerlPC2.dll will export a bunch of functions that are responsible for initiating the communication,
retrieving data and setting some control parameters.

The main difference to the former Version 1 (ImagerIPC.d11) is the support of more than one TIM cameras
via multiple instances of TIM Connect.
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A 11 thermolMAGER TIM Connect Resource Translator

l A detailed tutorial is provided on the USB stick.

thermolMAGER TIM Connectis a .Net Application. Therefore it is ready for localization. Localization as a
Microsoft idiom means the complete adaption of resources to a given culture. Learn more about the interna-
tionalization topics consult Microsoft’s developer documentation on

http://msdn.microsoft.com/en-us/goglobal/bb688096.aspx.

If desired the localization process can be illustrated in detail. Also, the resizing of buttons or other visible
resources and the support of right-to-left languages is supported. Experts who have the appropriate tools
should handle it. To limit this effort and to enable anybody to translate the resources of the TIM Connect ap-
plication Micro-Epsilon has developed the small tool Resource Translator.

This tool helps to translate any visible text within the thermolMAGER TIM Connect application.
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A12 Process Interface for thermolMAGER TIM 40

GER TIM 40

A12.1 Analog Output

The maximum load impedance is 500 Ohm.

The analog output can be used as a digital output too. The current value for no alarmand alarm on is set

within the software.

A12.2 Digital Input

GND:

DIGITAL IN—H—;EE_'
562

R

3,6v

ce

Fig. 61 Digital input

The digital input can be activated with a switch to the TIM GND or with a Low level CMOS/TTL signal:
- Lowlevel0...0.6V
- Highlevel 2 ...24V

DIGITAL IN=—

s

N1 S EXT

GND=———

Fig. 62 Button example
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A 123 Analog Input

R4
L t
L I1C4
m o w—
GND

Fig. 63 Analog input

Useful voltage range: 0 ... 10 V
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A12.4 Relay Output on Industrial Interface
The analog output has to be setto Alarm.

The voltage level for AO1 - AO3 can be set in the software:
- noalarm: 0V
- Alarm:2-10V

REL1-3 (D01-D03): U_, = 30 VDC
| =400 mA
PIF_3U3= : .

LS T776-R1SL (red

PIF_RELA

PIF_GNDs.

Fig. 64 Relay output
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